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Access the End-User Help Files
The Unity Client includes help files for end-users. These can be 
referenced at any time in the Unity Client either by pressing the 
F1 button on your keyboard, or by clicking the Help button:

The help files are opened in a separate window. 

Set Your Home Page
The Home button takes you to your configured Home Page.

To set a layout to be your Home Page, navigate to the desired 
layout and select Make this layout my Home Page from the 
Home button drop-down menu.

To reset your Home Page to the default, select Reset Home 
Page from the Home button drop-down menu.

Add Favorites
You can add the currently displayed layout to your list of 
favorites by performing the following steps:
1. Click the Favorites button:

2. Click Add this layout to my favorites.
The favorite can be accessed by clicking the Favorites 
button again and selecting the favorite from the list.

Use the Personal Page
Many OnBase items and layouts can be added to your Personal 
Page as tiles. Tiles serve as easy access points to the files, 
items, and interfaces of your choice.

The Personal Page can be opened by clicking the Personal Page 
ribbon button:

To add an item or layout to the Personal Page, right-click the 
object and select Add To Personal Page. If the right-click option 
is unavailable, the Personal Page option may be included under 
the Send To functions or, as is the case with Custom Query 
results, as a special menu option to Add to Personal Page. 

When adding an entire layout to your Personal Page, select 
Personal Page | Add this layout to my Personal Page from the 
ribbon menu.

Document Retrieval
You can retrieve documents in the Unity Client based on the 
document’s keyword values, the text contained within the 
document, or the note information contained on a document. 
The following example describes how to retrieve documents 
based on their keyword values.
To access Document Retrieval:
1. In the Documents ribbon group on the Home tab, click 

Retrieval.

2. In the Document Retrieval pane, select a Document Type 
Group.
Select a Document Type.

Note: The information contained in the panel may dynamically
change based on the Document Type Group or Document Type
you selected.
3. If desired, you can specify a date range to only return 

documents that were created or imported between a 
certain range of dates.

4. A list of keyword fields displays below the date range.

Enter values for the keywords that are displayed. You can 
enter as much or as little information you know.
Note: Some searches require you to enter at least one keyword
value. Search requirements are determined by your system
administrator.
5. When you have entered all search criteria, click the Find 

button at the bottom of the panel.

Use the Personal Page (Continued)
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The Search Results are displayed in a list on the right side 
of the screen.

6. Double-click a document from the list to open it. 

Import Documents
To import documents in the Unity Client:
1. In the Create ribbon group on the Home tab, click Import.

The Import layout is displayed.
2. Select the document you want to import by doing one of 

the following actions:
• Browse to the file location of the document you are 

importing by clicking the Browse button,
• Scan a document, or import a document image from 

another supported digital storage device such as a 
scanner or camera, by clicking the Acquire button,

• If configured, select a document stored or created in 
Google Drive by clicking the Drive button, or 

• Drag and drop the file you want to import into the white 
space next to the Import pane.

3. Select a Document Type Group for the document.
Select a Document Type for the document.

4. Enter all of the necessary keyword values in each field.
5. When you are finished entering the necessary keyword 

values, click the Import button to import the document into 
OnBase:

Document Separation
Image and PDF documents can be manipulated in the 
Document Separation layout. Documents and their individual 
pages can undergo multiple editing processes in this layout 
such as splitting, joining, rotation, and copying. Documents can 
be deleted or created within Document Separation. Pages can 
be dragged to different documents, or to an empty area to 
create a new document.

Document Retrieval (Continued)

To send one or more documents to Document Separation, 
select Split from the Re-Index pane, the Edit Pages button in the 
Image tab of an open document, the Send To | Document 
Separation option from the ribbon or right-click menu, or drag 
and drop the document(s) into an existing Document 
Separation window.
To switch between Document Display Mode and Page Display 
Mode, toggle the Group by Documents button:

 

D

Keep important pages separate while reorganizing and editing 
documents by dragging them to the Page Holder.
Double-click a page to open it in Detailed View, which allows for 
full-scale viewing, rotation, and flipping.
Click Join to join two or more documents through the Merge 
Documents, Join Pages, or Append After Page options.

Click Split to separate a document through the Split or Break 
into Documents options.

The thumbnails within Document Separation can be adjusted by 
accessing the Thumbnail Settings from the ribbon menu.

Envelopes
Envelopes are collections of documents that you can compile 
and share with other OnBase users. Any document can be put 
into an envelope, regardless of content or Document Type.
Envelopes can be created and viewed by clicking the Envelopes 
ribbon button on the Home tab.

Select an envelope to view its contents.
If you would like to share an envelope with other users, select 
the desired envelope and click Share Envelope.

Selected Users are the users sharing the envelope with you. 
Users can have Full Control over the envelope, can be permitted 
to Add to Envelope and/or Remove from Envelope, or can just be 
allowed to view the envelope contents. Adjust user permissions 
as needed.

Document Separation (Continued)
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User Options
System functionality and appearance can be customized in the 
User Options. The User Options dialog is accessed through the 
User Options button in the File Menu.

General Unity Client behavior and display features, Document 
display options, Document Import options, Printing options, 
Retrieval Date options, and Service Mode options can be set 
here.
Note: The Service Mode tab is only available when the Unity
Client is running in Service Mode.
Note: Some User Options may be enforced by an administrator-
designated User Option Policy.
To apply User Options: 
1. Select the desired options in each tab. Selection controls 

for options vary (check boxes, text fields in which you can 
insert a number or date range, etc.). 

2. After you have selected the appropriate options, click Save 
to save your changes and to close the User Options 
dialog.

Generate CSV Files
Document Search Results lists can be exported as .csv files. 
CSV files can contain metadata pertinent to the documents 
included. Keywords, DocPop URLs, and Document Dates are 
examples of information fields that can be included in your CSV 
output.
Note: CSV files cannot be generated from Full Text Search
result lists. 
To generate a CSV file:
1. Right-click within a Document Search Results list and 

select Generate CSV File. The Generate CSV File window 
is displayed.

2. Configure your file as desired.The document Range and 
resulting Columns within the CSV file can be adjusted 
here.

3. In the Save to File field, enter the name and location that 
will be used to save the CSV file. You can select Browse to 
navigate to the correct location.

4. Click Launch Associated Application if you would like to 
view the CSV file after you click Generate. The file will be 
opened by your default CSV application.

5. Click Generate. The CSV file has been created at the 
specified location.

Or click Cancel to cancel the process and return to the 
search results list.

Send Mail
Internal mail messages can be sent to other OnBase users. 
Documents and folders can be sent within the Unity Client to 
other users. If you need to send documents to non-OnBase 
users, external mail messages can contain documents as 
attachments, or can include documents, folders, Custom Query 
Results, E-Forms, and Unity Form Creation pages as Unity Pop 
Links or Unity Pop Files. Recipients of Unity Pop Links and Files 
must be OnBase users.
Send To | Internal User

Selecting this option will allow you to send the selected or 
open document or folder to another OnBase user. A new mail 
message dialog is displayed and recipients, attachments, 
and message body text can be edited as needed.

Received internal mail messages can be checked by clicking 
the Mailbox button in the ribbon menu.
Send to | Mail Recipient

Selecting one of the two Mail Recipient options will allow you 
to send the selected or open item to a user outside of 
OnBase.
Note: A functional, supported email client is required to send
OnBase items externally.

Selecting Send to | Mail Recipient (as Attachment) will attach 
the document(s) to a new message dialog in your configured 
external email client.

Selecting Send to | Mail Recipient (as Link) opens a blank 
email message containing a link to the item(s) or XML file 
that references the content in OnBase, depending on your 
configuration.

Document List Organization
Document lists can be organized to better suit your needs. Lists 
can be organized through grouping, sorting, column reordering 
and stacking, and filtering through operators and drop-down 
lists.
Grouping

Drag a column heading to the space above a data list to 
group the list by that column.
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Sorting

Lists can be sorted by column values. Click on a column 
heading to sort the list in descending order. Click the column 
heading again to sort in ascending order.

Reordering and Stacking Columns

Click and drag a column to the area between two columns to 
move it to that location:

Click and drag a column onto the header of a different 
column to stack the columns:

Document List Organization (Continued)
Filtering

The Custom Queries, Document History, Document Retrieval, 
Mailbox, and Users layouts support filtering. Operators, drop-
down lists, and custom filters are available methods of list 
filtering.

Click the operator button in the desired column to view 
available operators:

Click the drop-down list arrow to view available drop-down 
list options:

Note: Operator and drop-down list options vary by column.

Select Custom from a drop-down list to open the Custom 
Filter Selection dialog box. You can create your own data list 
filter using conditions and operators.

Document List Organization (Continued)
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Note: For each shortcut, press all keys at the same time.

Global
Alt When on the Home tab, shows shortcut 

keys for the ribbon tabs and File menu.
Note: The functionality of shortcuts using
Alt may vary depending upon the active
window, tab, or pane.

F1 Accesses the help files.

Alt + Space Opens the system menu for minimizing, 
maximizing, and restoring the program.

Alt + F4 Closes the program.

Main Window
Ctrl + M Opens the Home layout.

Ctrl + Q Opens the Custom Queries layout.

Ctrl + R Opens the Document Retrieval layout.

Ctrl + E Opens the Forms layout.

Ctrl + N Opens the current layout in a new 
window.

F8 Opens the Import layout.

Data Lists
Ctrl Hold to select multiple items in a list.

Ctrl + A Selects all items in a list.

Ctrl + Shift + End Selects all items below the selected item 
in a list, including the selected item.

Ctrl + Shift + 
Home

Selects all items above the selected 
item in a list, including the selected item.

Keywords
F3 Changes the operator for the selected 

Keyword Type.
F4 Changes the connector for the selected 

Keyword Type.
F5 Shows the drop-down list for the 

selected Keyword Type.
F6 Adds another value for a Keyword Type.

Ctrl + O Collapse or expand any Multi-Instance 
Keyword Type Group.

Re-Indexing
Esc Closes the Re-Index pane.

Import Layout
Ctrl + O Opens the Browse dialog box.

Ctrl + S Uploads the document.

Esc Cancels the upload and clears the Import 
pane.

Ctrl + Shift + Up 
Arrow

Moves the page selected in the Preview 
pane up one position in the page order 
of the document.

Ctrl + Shift + 
Down Arrow

Moves the page selected in the Preview 
pane down one position in the page 
order of the document.

Delete Removes the page selected in the 
Preview pane from the document.

Ctrl + Delete Removes all pages from the document.

Ctrl + Left Arrow Rotates the page selected in the Preview 
pane counterclockwise.

Ctrl + Right 
Arrow

Rotates the page selected in the Preview 
pane clockwise.

Document Viewer
Ctrl + H Opens the Document History dialog box.

Ctrl + P Opens the Print pane.

Ctrl + K Opens the Add/Modify Keywords pane.

Ctrl + W Opens the Cross-References pane.

Ctrl + U Toggles the thumbnail display.

Ctrl + O Toggles text overlay when working with 
image documents.

Ctrl + Mouse 
Wheel Up or Ctrl 
and +

Zooms in on the document.
Note: Ctrl + is not usable when working
within a text document. Use the Ctrl Mouse
Wheel Up shortcut to zoom in on text
documents.

Ctrl + Mouse 
Wheel Down or 
Ctrl and -

Zooms out on the document. 
Note: Ctrl - is not usable when working
within a text document. Use the Ctrl Mouse
Wheel Down shortcut to zoom out on text
documents.

Mouse Wheel 
Up /
Page Up /
Up Arrow

Navigates up through pages in a multi-
page document.

Mouse Wheel 
Down /
Page Down /
Down Arrow

Navigates down through pages in a 
multi-page document.

Ctrl + Page Up 
or F11

Displays the previous page in a multi-
page document.

Ctrl + Page 
Down or F12

Displays the next page in a multi-page 
document.

Ctrl + Home Displays the first page in a multi-page 
document.

Ctrl + End Displays the last page in a multi-page 
document.

Ctrl + Shift + 
Page Up

Displays the previous document in the 
Document Search Results list.

Ctrl + Shift + 
Page Down

Displays the next document in the 
Document Search Results list.

Ctrl + G Opens the Go to Page dialog box.

Ctrl + Right 
Arrow

Rotates the currently selected pages 90 
degrees clockwise.

Ctrl + Left Arrow Rotates the currently selected pages 90 
degrees counterclockwise.

Import Layout
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Ctrl + Down 
Arrow

Rotates the currently selected pages 
180 degrees.

Document Separation
Delete Deletes selected pages.

Esc Exits the Document Separation layout 
without saving changes.

Ctrl + S Saves selected documents.

Ctrl + H Flips selected pages horizontally.

Ctrl + . Rotates selected pages 90 degrees 
clockwise.

Ctrl + , Rotates selected pages 90 degrees 
counterclockwise.

Ctrl + J Joins selected pages.
Note: This operation is only used in Page
Display Mode.

Alt and + Copies the selected document.

Ctrl and + Copies selected pages in a new 
document.

Ctrl and Shift 
and +

Copies the selected pages.

Ctrl + C Copies individual pages to the clipboard.

Ctrl + X Cuts individual pages.

Ctrl + V Pastes individual pages.

Shift + Click Selects all pages between two selected 
pages. Shift must be held while clicking.

Ctrl + Click Selects or deselects a page without 
deselecting other pages or documents.

Ctrl + Drag Copies the page being dragged and 
dropped instead of moving the page to 
the new insertion point.
Note: This operation is only used in
Document Display Mode.

Ctrl + Shift + 
Click

Selects multiple page ranges in multiple 
documents. These buttons must be held 
while clicking.
Note: This operation is only used in
Document Display Mode.

Ctrl + Delete Enters Delete Mode.

Alt + Home Scrolls to the first selected page of a 
document, if not already in view.

Up Arrow / Page 
Up

Scrolls up in the Separation Workspace.
Note: This operation is only used in
Document Display Mode.

Down Arrow / 
Page Down

Scrolls down in the Separation 
Workspace.
Note: This operation is only used in
Document Display Mode.

Ctrl + Mouse 
Wheel Up

Zooms in on the page open in Detailed 
View.

Ctrl + Mouse 
Wheel Down

Zooms out on the page open in Detailed 
View.

Document Viewer
Ctrl + Left Arrow Rotates the page open in Detailed View 

90 degrees counterclockwise.
Ctrl + Right 
Arrow

Rotates the page open in Detailed View 
90 degrees clockwise.

Document Separation


